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RESUMEN 

Eficiencia del diseño y simulación hidráulica con Watercad de la Red de distribución 
de agua potable de la Asociación Pro vivienda Nuevo Habana  

 

El presente esfuerzo académico titulado Eficiencia del diseño y simulación hidráulica con 

Watercad de la Red de distribución de agua potable de la Asociación Pro vivienda Nuevo 

Habana, se realizó teniendo en cuenta la necesidad del servicio de agua en la Asociación 

Pro vivienda Nuevo Habana del Distrito de Habana, en ese sentido, se realizaron cálculos 

hidráulicos y se ejecutó la simulación en período estático y período extendido del sistema 

planteado para finalmente contrastarlo con la normativa peruana vigente. Se solicitó 

información a la Municipalidad Distrital de Habana, referente a datos población, presiones, 

caudales y redes más cercanas a la Asociación; posteriormente se visitó al sector en 

investigación a fin de conocer el relieve topográfico del área, con la cual se completó la 

información básica para transformar los datos obtenidos. Finalmente, comparando con la 

OS. 050, Redes de distribución de agua para consumo humano del Reglamento Nacional 

de Edificaciones, se obtuvieron presiones, velocidades y diámetros de tuberías favorables 

tanto en la simulación en periodo estático como en la simulación en período extendido. Por 

lo que la aplicación del sistema planteado resultaría eficiente y favorable para el normal 

abastecimiento de la Asociación.  

 

Palabras clave: Watercad, Simulación, agua, tubería.  
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ABSTRACT 

Design efficiency and hydraulic simulation with Watercad of the drinking water distribution 
network of the Nuevo Habana Pro-housing Association 

 

The present academic effort entitled " Design efficiency and hydraulic simulation with Watercad of 

the drinking water distribution network of the Nuevo Habana Pro-housing Association", was carried 

out taking into account the water service needs of the Nuevo Habana Pro-housing Association in the 

District of Habana. In this sense, hydraulic calculations were made and the simulation of the 

proposed system was carried out in static and extended periods in order to compare it with the 

Peruvian regulations in force. Information was requested from the District Municipality of Habana 

regarding population data, pressures, flows and networks closest to the Association; subsequently, 

a visit was made to the sector under study to learn about the topographic relief of the area, with 

which the basic information was completed in order to transform the collected data. Finally, 

comparing with OS. 050 "Water distribution networks for human consumption" of the National 

Building Regulations, favorable pressures, velocities and pipe diameters were obtained both in the 

static period simulation and in the extended period simulation. Therefore, the application of the 

proposed system would be efficient and favorable for the normal supply of the Association. 

 

Keywords: Watercad, Simulation, water, pipe. 
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CAPÍTULO I 
 INTRODUCCIÓN A LA INVESTIGACIÓN 

 

Países de Latinoamérica y el Caribe destacaron tiempo atrás lo sustancial del 

abastecimiento de agua y saneamiento como punto de quiebre para preservar y mejorar el 

servicio básico de salud en sus conciudadanos, en la región hay unos 222 millones de 

residentes que carecen de agua potable gestionados de forma segura. Las brechas de 

cobertura en agua y saneamiento entre países son grandes, así como dentro de los 

mismos países, contando que la brecha dentro de los países es más del 20 o incluso el 

30%. Las poblaciones carentes con servicios básicos buscan saldar esta necesidad 

optando por medidas alternativas (tales como, para proveerse de agua: pozos individuales, 

conexiones clandestinas a la red de agua, comerciantes de agua, o consumir agua 

directamente de ríos, lagos y/o de otros orígenes; y para el saneamiento: letrinas y/o 

defecación a tajo abierto). Normalmente, estas poblaciones han sufrido un crecimiento muy 

acelerado y/o geométrico y desordenado, lo que ha conllevado a que se asienten en puntos 

muy alejados de las redes existentes y en condiciones topográficas de difícil acceso. En 

los países de la región, existe un contraste marcado en las zonas urbanas y rurales, siendo 

el 13% para el abastecimiento de agua y del 22% para disposición de agua servidas, ello 

tomando como punto de referencia la accesibilidad a por lo menos un servicio básico. 

(WWAP París UNESCO, 2019). 

El 90,8% (29 millones 525 mil) de la población de la nación tuvo acceso a agua para 

consumo humano de la red pública en el año móvil de mayo 2019 a abril 2020, según el 

Instituto Nacional de Estadística e Informática (INEI) (dentro de la vivienda, fuera de la 

vivienda, pero dentro de la edificación o red pública de agua). El 9,2% del total de personas 

a nivel nacional no tiene acceso a la red pública de agua, sino que se abastece de otras 

fuentes como pozos (1,6%), camiones cisterna (1,2%), ríos, acequias, manantiales (3,5%) 

y otras fuentes (2,8%). En 2019, el 94,9% de las personas en zonas urbanas y el 75,6% 

de las personas en zonas rurales tenían acceso a redes públicas de agua, y el 24,4% de 

este último grupo utilizaba agua de acequias, ríos, manantiales u otras fuentes similares. 

En el distrito de Habana, existe actualmente una gran población en la asociación Pro 

vivienda Nuevo Habana sin el servicio de agua potable, y actualmente se está sirviendo de 

la quebrada el Galdín el mismo del que se sirven bestias y agricultores para el lavado de 

café. En ese sentido, el presente trabajo pretende brindar una alternativa de solución al 

problema de abastecimiento de agua potable en la asociación, brindando un diseño de red 

de abastecimiento en concordancia con las normas vigentes, generando un gran impacto 
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en la población de la asociación, ya que contar con agua potable y segura es indispensable 

para el buen desarrollo del distrito. 

El presente tubo de base primordial la utilización del Software Watercad; la cual, en la 

actualidad es utilizada en gran manera en el campo de la ingeniería para el diseño de 

tuberías a presión, repercutiendo en la toma de decisiones al momento de trasladarlo al 

campo. 

La variable dependiente fue la red de distribución de agua potable, que será confirmada 

por el OS 050, Redes de distribución de agua para consumo humano del Reglamento 

Nacional de Edificaciones. La variable independiente asumida fue el diseño y simulación 

hidráulica con Watercad, la cual se verificó a través de cálculos hidráulicos y a través de la 

simulación en periodo estático y extendido. 

El objetivo principal fue: Determinar la eficiencia del diseño y simulación hidráulica con 

Watercad de la red de distribución de agua potable de la asociación Pro vivienda Nuevo 

Habana; y tuvo como objetivos específicos: Diseñar mediante cálculos hidráulicos la red 

de distribución de agua potable de la Asociación Pro vivienda Nuevo Habana con la 

aplicación del Watercad, Simular en periodo estático y periodo extendido la red de 

distribución de agua potable de la Asociación Pro vivienda Nuevo Habana con la aplicación 

del Watercad y por último determinar velocidades, diámetros de tuberías y presiones en la 

red de distribución de agua potable de la Asociación Pro vivienda Nuevo Habana. Así 

también, la hipótesis de trabajo en la presente fue, la eficiencia del diseño y simulación 

hidráulica con Watercad de la red de distribución de agua potable para la Asociación Pro 

Vivienda Nuevo Habana, dará solución a este problema de servicio que ayudará a los 

pobladores de este sector. 

Se utilizaron métodos de entrevistas informales con operarios que trabajan en la 

administración de los servicios de saneamiento del Distrito de Habana, así como también 

la inspección ocular en las visitas de campo realizadas, equipos topográficos para el 

levantamiento topográfico de la zona de estudio y softawares como el Autocad, el Arcgis, 

el Civil 3d y otros como el Word y Exel. 
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CAPÍTULO II 

MARCO TEÓRICO 
 

2.1. Antecedentes de la investigación 

Gamboa y Rico (2020), determinaron “la elaboración del modelo hidráulico para la red de 

distribución de agua potable de Funza Cundinamarca utilizando el Software Epanet”. El 

objetivo principal fue analizar y ampliar el modelo hidráulico de la red de distribución de 

agua potable de Funza Cundinamarca. Para ello se analizaron hidráulicamente las 

presiones y velocidades, teniendo en cuenta las ventajas y limitaciones del elemento 

líquido para la conducción del municipio, llegándose a concluir que en un alto porcentaje 

las presiones del sistema son muy coherentes en la mayoría de los sectores, con excepción 

de aquel tubo proveniente de tienda nueva que es utilizado para extraer agua subterránea, 

respecto a las velocidades entre el 45% y 50% durante las horas picos son altas y sus 

velocidades son mayores a 0,5 m/s sin exceder los 2 m/s. 

Ampié y Masis (2017), investigó una propuesta de diseño hidráulico a nivel de pre 

factibilidad del sistema de abastecimiento de agua potable y saneamiento básico de la 

comunidad Pasó Real, municipio de Jinotepe, departamento de Carazo; tuvo por objeto 

principal proponer el diseño hidráulico como pre factibilidad del sistema de abastecimiento 

de agua potable y saneamiento básico para la comunidad Paso real. Se determinó que la 

comunidad Paso Real consta con 279 pobladores. Se concluyó que de acuerdo al 

diagnóstico realizado solo se cuenta con un manantial de agua subterráneo, la cual renta 

40 gpm sacada a través de un bombeo artesanal, proponiéndose que el diseño hidráulico 

más óptimo y eficaz conste con un sistema Fuente-Tanque-Red que inicialmente será de 

beneficio para 304 habitantes teniendo como horizonte de vida a veinte años. Se propone 

también un saneamiento básico a través de letrinas de hoyo seco ventilado, por su facilidad 

constructiva, siendo una de sus principales funciones prevenir la proliferación de bacterias, 

insectos y hasta virus en el interior; llegándose a estimar un presupuesto de C$ 1, 592, 

161.76 de todo el sistema de saneamiento. 

Yarleque (2019), determinó un diseño de la red de distribución de agua potable del A.H. 

Alfonso Ugarte y alrededores del distrito de Veintiséis de Octubre, provincia de Piura, 

departamento de Piura, marzo 2019, consideró al objeto central de su trabajo realizar el 

boceto de la red de distribución del sistema de agua potable, para ello se tuvo en cuenta a 

125 viviendas en los cuales moran 730 habitantes. Se aplicó una metódica cualitativa y 

explicativa en el que se recopiló información que se generaron de las visitas realizadas al 
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Asentamiento Humano y sus entornos, Empresa Prestadora de Servicios de Saneamiento 

Grau, Comuna del distrito Veintiséis de Octubre e INEI. En el diseño considerado en este 

trabajo, para la tubería de aducción e impulsión consideró tuberías PVC SAP C10 de un 

diámetro 3 pulg., en cuanto a redes de distribución cuya función será de repartir el agua 

potable en el sistema cerrado se considerará un diámetro de tubería de 2 ½ pulg.; así 

mismo, se propone un almacenamiento de 100 m3, una cisterna de 86.90 m3 y un bombeo 

mediante una intensidad de 5 HP. Finalmente, la propuesta de diseño de las redes de 

distribución en el Asentamiento Humano antes mencionado y sus alrededores se realizó 

haciendo uso de softwares que utilizan como base algorítmica el método de áreas, la cual 

se considera como válida en las normativas vigentes de edificaciones. 

Huamán y Rojas (2019), realizaron un diseño de la red de abastecimiento de agua potable 

proveniente de una planta desalinizadora para abastecer cuatro balnearios de Lima en el 

distrito de Santa María del Mar – Lima. El objetivo principal fue proponer, mediante una 

técnica observacional, prospectiva y transversal, un diagrama de red para el 

abastecimiento de agua potable desde una planta desalinizadora para los balnearios de 

Punta Negra, Punta Hermosa, Santa María del Mar y San Bartolo. Asimismo, se consideró 

la totalidad del marco legal y la normativa peruana vigente en materia de suministro de 

agua para uso humano, tales como la IS.010, OS.050, OS.010 y OS.100 del RNE. 

Concluyendo que para la presente investigación si se considera un reservorio con una 

capacidad de 29000 m3 ésta satisficiera la necesidad completa de una población de 117 

630 habitantes; destacando de esta manera la importancia del uso de softwares modernos 

en proyectos de gran escala, ya que ello facilita considerablemente los cálculos realizados 

que serán llevados a campo para ser ejecutados. 

Quilca (2020), en su tesis “Análisis y simulación en período extendido del sistema de agua 

potable en el centro poblado de Amparani, distrito de Acora, provincia de Puno, 

Departamento de Puno” tuvo como objetivo central examinar las peculiaridades de la 

conducta hidráulica del sistema, esto debido a que no se cuenta con una continuidad del 

suministro de agua potable; en consecuencia, se determinó cuan influyente es la variación 

de consumo horario, así también, utilizando el software WaterGems se realizó la 

simulación en período extendido. Teniendo un gasto máximo cada hora de 32.46 litros y el 

coeficiente de variación en cada hora de 3.09, conocido comúnmente como K2. 

Finalmente, concluyó que la variación de gasto de agua calculada en la investigación era 

diferente a la variación de gasto de agua considerada para el diseño, lo que deriva en la 

no continuidad del servicio de agua potable; a lo que en base a lo determinado en el 

presente trabajo se propusieron modificaciones en el servicio. 
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Torres (2019), realizó su trabajo en un “Diseño y simulación hidráulica del sistema de 

abastecimiento de agua potable de la urbanización las brisas de la ciudad de     

Moyobamba – 2018”, como oferta, simuló hidráulicamente la red de abastecimiento de 

agua potable de la Urbanización las Brisas; la investigación se dividió en tres etapas: 

recogida de datos sobre el terreno, tratamiento en oficina de todos los datos extraídos 

sobre el terreno y, en la tercera etapa, diseño y simulación óptima de la red mediante 

WaterCAD; el resultado obtenido fue que, por la topografía del lugar, el abastecimiento de 

agua en la urbanización no se podría realizar de manera convencional, es decir por 

gravedad; por lo que, para un abastecimiento óptimo se propuso un sistema de bombeo, 

la cual requerirá bombear el líquido elemento haciendo uso de una intensidad de 7.17 HP, 

la misma que se realizará desde los filtros rápidos de la PTAP - San Mateo hacia un 

reservorio elevado con capacidad de almacenamiento de 23 m3, a fin de que por medio de 

las redes de distribución se abastezcan todos los moradores. Finalmente se concluye 

afirmando que lo ejecutado cumple con todo lo requerido por la normativa peruana vigente 

y con lo requerido por la la Urbanización. 

Hoyos y Tuesta (2017), trabajó en una, “simulación hidráulica de las redes de distribución 

del barrio Zaragoza a partir de la determinación de los coeficientes de variación diaria y 

horaria, para futuras habilitaciones urbanas de la ciudad de Moyobamba 2016”. Concluye 

que, teniendo en cuenta la cuantificación proporcionada por el RNE al coeficiente de 

variación horaria (K2) = 1.8 – 2.5, la cual al ser contrastada con el K2 = 2.4281 calculada 

en la presente investigación, se aprecia que el resultado obtenido se encuentra inmiscuido 

en los parámetros predeterminados por la normativa; empero, al contrastar el coeficiente 

de variación diaria (K1) = 1.5055 calculada en la investigación, con el (K1) = 1.3 establecido 

por el RNE, llegamos a la conclusión que lo obtenido no guarda correspondencia con la 

normativa. Finalmente, al realizar la simulación hidráulica haciendo uso de lo establecido 

por la normativa respecto al K2 = 1.8 se llegó a determinar que respecto a presiones y 

velocidades obtenidos no se ajusta a lo requerido por el RNE; todo lo contrario, sucedió al 

simular con el K2 = 2.4281 calculado, llegándose a obtener una mejora del 100% de las 

presiones y un 18% de las velocidades requeridas por el RNE. 

2.2. Fundamentos teóricos 

2.2.1 El agua  

Es una sustancia sin vida (abiota), pero que a su vez genera vida, influyendo crucialmente 

en el desarrollo de la vida para muchos organismos vivos en el planeta. Amaya (s.f.)  refiere 

que:  
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Es la más sustancial del planeta y uno de los más fundamentales elementos que conforman 

el ambiente en el que nos desarrollamos y de la materia viva; así también en estado líquido 

cubre un porcentaje considerable del terreno del planeta, distribuyéndose en cuencas 

saladas, dulces, la humedad atmosférica y estado sólido la nieve y/o el hielo.  

2.2.2 Sistema de Abastecimiento de Agua Potable  

Un sistema de abastecimiento de agua apta para consumo humano, tiene por objeto 

principal, dar a los moradores de un pueblo agua en calidad y en cantidad, la cual supla 

las necesidades de los mismos; esto sabiendo que el 70% del cuerpo de los humanos lo 

compone el agua, a lo que este fluido es indispensable para el desarrollo de su vida. 

(Jiménez, s.f., p.16) 

Un sistema de abastecimiento de agua potable no difiere de cualquier otro sistema 

integrado por componentes que trabajan en conjunto para formar un todo; según Jiménez 

(s.f.), incluye captación, conducción, potabilización, regularización, línea de 

abastecimiento, red de distribución y obras conexas o complementarias (p. 16). A 

continuación se presenta un amplio gráfico de los rubros mencionados: 

 

 

 

 

 

 

 

Figura 1.  

Proceso general de abastecimiento de agua potable  
 

Nota: De Diseño de la red de abastecimiento de agua potable proveniente de una planta 
desalinizadora para abastecer cuatro balnearios del sur de Lima en el distrito de Santa María del 
Mar – Lima (p.36), por Huamán y Rojas, 2019 (https://hdl.handle.net/20.500.12727/5893). 

 

2.2.3 Partes de un sistema de Abastecimiento de Agua Potable 

2.2.3.1. Captación 

Se conoce como captación a aquella obra civil que permite evacuar el agua desde su 

fuente natural, ya sea superficial o subterránea a través de los diferentes componentes del 

sistema. 
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Según Quilca (2020), es un método cuyo objeto es contribuir con una buena explotación 

de una fuente de agua, así también posibilitar que los caudales solicitados por la población 

se evacúen correctamente. Para aguas superficiales como los ríos, se erigen bocatomas, 

entre tanto que para aguas subterráneas se perforan pozos, hasta llegar a acuíferos, 

finalmente para aguas que se obtengan de precipitaciones pluviales, se construirán obras 

que recojan y a la vez conduzcan dichas aguas hasta un lugar de almacenamiento (p.26). 

2.2.3.2. Línea de conducción 

La línea de transmisión y/o conducción es aquella tubería proyectada para conducir el 

caudal máximo por día, a través de un diámetro previamente calculado lleva el agua cruda 

captada desde la fuente de abastecimiento hasta el reservorio, atravesando componentes 

hidráulicos tales como desarenadores y planta de tratamiento.  

Según Ampie y Masis (2017), Para lograr un óptimo funcionamiento se le tendrá que dotar 

de las obras de arte y accesorios (válvulas, etc) correspondientes, teniendo en cuenta las 

presiones de trabajo con las que han sido diseñadas cada una de las tuberías, así como 

la operación y mantenimiento de las mismas. Si la topografía del terreno así lo requiera, se 

deberán instalar válvulas de aire en los puntos más alto y válvulas de “limpieza” en las 

partes más bajas (p.21). 

2.2.3.3. Planta de tratamiento 

Según Aguilar y García (2016), una planta de tratamiento está conformada por varias 

estructuras, las cuales por separado cumplen diferentes funciones, sin embargo, en 

conjunto tienen un solo objetivo que es el de purificar el agua y hacerla apta para el 

consumo poblacional, reduciendo cada uno de los contaminantes que se encuentren en el 

agua (p.17). 

2.2.3.4. Tanque de almacenamiento 

Es un componente estructural, que se construye en todo sistema de abastecimiento de 

agua, con la finalidad de almacenar agua y poder cubrir con las demandas máximas y 

presiones mínimas en las redes que se requerirán a lo largo de todo el tiempo de vida útil 

del sistema. Así mismo, en sistemas que cuentan con hidrantes contra incendios, será 

indispensable almacenar un volumen de agua extra que ayude a cubrir y poder enfrentar 

dicha circunstancia (Ampié y Masis, 2017, p. 19). 

2.2.3.5. Red de abastecimiento 

La red de distribución de agua potable, de acuerdo con representantes de la Comisión 

Nacional del Agua (CONAGUA) (s.f.), es un sistema de tuberías, accesorios y otras 
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estructuras y componentes que transportan el agua hasta los hidrantes públicos o tomas 

domiciliarias con el objetivo de abastecer de agua a una población específica para su uso 

en sus hogares, comercios e industrias; del mismo modo, Huamán y Rojas (2019), afirman 

que, “es un sistema formado por un conjunto de tuberías, válvulas y otras piezas especiales 

que permiten la distribución del agua desde el reservorio hasta las viviendas. Las tuberías 

pueden formar redes principales, secundarias o terciarias”. 

 Consideraciones para el diseño de una red de abastecimiento poblacional 

De acuerdo con Hoyos y Tuesta (2017), los factores a considerar, particularmente mientras 

se lleva a cabo el diseño, modelado y simulación de la red de distribución de agua potable, 

incluyen; 

Verificar las restricciones que conllevan a un escenario adverso, a fin de realizar la mejor 

aplicación de los coeficientes que determinan el consumo máximo diario y horario (K1 y 

K2). Las redes en su funcionamiento se someten a diferentes condiciones, por lo que las 

redes deben garantizar presiones máximas y mínimas de agua potable; por lo que el RNE 

establece que no debe existir una presión de agua menor a 10 m.c.a., ni mayor a 50 m.c.a. 

Las tuberías de distribución estarán conformadas por diámetros de 8”, 6”, 4” y 2” que 

contengan válvulas para el mantenimiento y moderamiento del flujo, sumado a ello se 

insertarán grifos contra incendio ubicados convenientemente (p.11). 

 Factores intervinientes en el diseño de la red.  

Se tiene en consideración la ubicación topográfica, la factibilidad y la ubicación de las 

fuentes de abastecimiento, así como de la conexión domiciliaria más desfavorable, a fin de 

poder ubicar correctamente el tanque de almacenamiento, y tener una correcta 

determinación del tipo de red. Con la ayuda del WaterCAD y Epanet se colocarán los 

diámetros de tuberías, elevaciones de nodos y caudales (Vierendel, 2009, p.89). 

 Consideraciones generales respecto al trazo de la red  

 Sistema de circuito abierto  

Espina de pescado.  

Llamada así porque está basada en la figura del esqueleto de un pescado común y 

corriente; el sistema considera una tubería matriz como columna vertebral de diámetro 

mayor a las demás, que recorre la calle principal del pueblo y en su trayecto va dejando 

ramificaciones que son tuberías de un diámetro mucho menor a la principal. Este sistema 

es principalmente el considerado para pueblos asentados longitudinalmente a lo largo de 

un acceso principal, como se observa en la figura N°2, siendo su principal inconveniente 

la no buena distribución de las presiones (Vierendel, 2009, p.90). 
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Figura 2.  
Sistema de circuito abierto tipo espina de pescado 
 

Nota: El gráfico muestra un tipo de redes de agua potable que se construye según la distribución de 
las viviendas a ser abastecidas. De “Abastecimiento de agua potable y alcantarillado” (p.90), por 
Vierendel, 2009. 

 

Parrilla  

Considera tuberías con diámetros mayor que las demás, pero en un sentido transversal y 

longitudinal por las calles más principales, las cuales alimentarán a las tuberías de menor 

diámetro por las calles menos principales. Conviene en pueblos pequeños y/o pequeñas 

ciudades que cuenten con calles principales según sus ejes no muy extendidas. También 

se cuenta con la misma dificultad que el sistema antecesor (Vierendel, 2009, p.90). 

 

 

 

 

 

 

 
Figura 3.  
Sistema de circuito abierto tipo parrilla  
Nota: El gráfico muestra un tipo de redes de agua potable que se construye según la distribución de 
las viviendas a ser abastecidas. De “Abastecimiento de agua potable y alcantarillado“ (p.91), por 
Vierendel, 2009. 

 

Sistema de circuito cerrado  

Radica en un conjunto de conductos esenciales las cuales circunvalan varias manzanas, 

de ellos se desprenden tuberías de diámetros menores que se encuentran unidas por sus 
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extremos al eje. Este sistema es apropiado en pequeñas y grandes ciudades, teniendo 

como favorable que el recorrido y la pérdida de carga es mínima ya que las tuberías de 

menor diámetro son alimentadas por ambos extremos (Vierendel, 2009, p.91).  

 

 

 

 

 

 

 
 

 
 
 

Figura 4.  
Sistema de circuito cerrado  
 

Nota: De “Abastecimiento de agua potable y alcantarillado “(p.91), por Vierendel, 2009. 

 

Selección del diámetro de tuberías 

El crecimiento demográfico y poblacional durante el período de diseño conlleva al aumento 

de consumo de agua potable y por ende al aumento de pérdidas del mismo debido a la 

fricción del agua en la tubería. La tubería a considerar será aquella que resulte óptima para 

suplir los criterios de diseño, así como económicamente accesible. Para ello se grafican 

los caudales y/o gastos en el período de tiempo de diseño adoptado versus las pérdidas 

(hf), así mismo analizar 3 ó 4 diámetros distintos o en su defecto de un diámetro, a fin de 

hallar las pérdidas con distintos gastos y luego hallar para cada uno de los casos 

analizados el presupuesto y la capacidad económica respecto al diámetro (Ampie y Masis, 

p.25) 

Tuberías 

Aguilar (2015), para su montaje es necesario se analice el gradiente hidráulico ya que 

mientras más ajustada se encuentre éste se menores presiones se obtendrán, las máximas 

presiones pueden monitorearse instalándose accesorios y/o válvulas de purga y aire que 

alivian la presión estática. La velocidad correcta del fluido en la tubería es esencial para 

evitar la sedimentación; para seleccionar el mejor tipo de tubería, hay que tener en cuenta 

factores como su vida útil, coste inicial, costes de mantenimiento y capacidad hidráulica. 
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La consideración más crucial es el tipo de agua que se va a utilizar, ya que afectará a la 

resistencia de la tubería a la corrosión. Existen muchos tipos de tuberías en el mercado; a 

continuación, se enumeran algunas de las mejores: 

 
 

Tuberías de fibrocemento (mezcla acuosa de cemento Portland y fibras de asbestos).  

- Tuberías de hierro fundido, que se fabrican con una combinación ferrosa de alto contenido 

en carbono.  

- Tuberías de hormigón (a veces hormigón armado con una capa metálica que lo recubre).   

- Tuberías de plástico hechas de cloruro de polivinilo, o PVC.  

- Tuberías de acero.  

- Tuberías de poliéster reforzado con fibra de vidrio. 

Tomando en cuenta los parámetros hidráulicos para tuberías se tienen los siguientes: 

- Nudos de entrada y salida.  

- Diámetro.  

- Longitud.  

- Coeficiente de rugosidad.  

- Estado (abierta, cerrada o con una válvula). 
 

Y los parámetros que se pueden obtener luego de la simulación son: 

- Caudal.  

- Velocidad.  

- Pérdidas.  

- Factor de fricción de Darcy-Weisbach.  

- Variación de la velocidad de reacción.  

- Variación de la calidad de agua. 

 

 Funcionamiento hidráulico de redes de distribución de agua potable  

Álvarez (como se citó en Torres, 2019), sostiene que; las redes de abastecimiento de agua 

potable cualquiera sea la población al que suministra agua potable y cualquiera sea el 

diseño topológico, están diseñadas para que al entrar en funcionamiento se comporten y 

trabajen hidráulicamente de la manera más correcta, a fin de que esto se lleve a cabo 

existen normas técnicas de diseño, que son diferentes tanto en un país como en otro, sin 

embargo, concuerdan en principios básicos de ingeniería; las cuales ayudan a ver qué tan 

correcto es el desempeño de una red hidráulica.  

Bajo esta dirección es necesario considerar que al acuñar una opinión respecto al 

desempeño hidráulico de las redes de agua potable se necesita resolver los parámetros 
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hidráulicos tales como la presión, velocidad, perdida de carga y caudal. Así como 

comprobar que los resultados se encuentren adentro de los valores requeridos por las 

normas del país. En resumen, una red se gestiona correctamente desde el punto de vista 

hidráulico si se tienen en cuenta sus parámetros hidráulicos -caudal, presión, velocidad y 

pérdida de carga- respetando los principios rectores de las leyes técnicas, que deben 

modificarse para cada lugar específico. 

En vuestro territorio el reglamento nacional de edificaciones, en el apartado OS.050 Redes 

de distribución del agua potable, determina los siguientes considerandos respecto a 

criterios hidráulicos:  

Velocidad  

Las velocidades máximas serán de 3 m/s. En ocasiones argumentadas se brindará una 

rapidez máxima de 5 m/s (Reglamento Nacional de Edificaciones OS.050 Redes de 

distribución de agua potable [RNE, OS.050], 2006.). 

Presiones  

Las presiones estáticas no serán superiores a las de 50 m.c.a en un punto cualquiera de 

la red. Para situaciones de consumo máximo horario, la presión dinámica no debe ser 

menor a 10 m.c.a. (RNE, OS.050, 2006). 

 Análisis hidráulico 

Las tuberías de distribución se trazarán, en un comienzo y siempre que sea compatible 

tratando de cerrar un circuito como una malla. La calibración se ejecutará teniendo como 

base los cálculos hidráulicos que nos aseguran su cantidad y presión optima de la red, 

avalando en lo posible una mesa de exactitudes correspondientes a la topografía del 

terreno. Para examinar el comportamiento hidráulico de las redes de distribución, se podrá 

utilizar la metodología de Hardy Cross o cualquier otro semejante. Para los cálculos 

hidráulicos de las tuberías, se utilizarán modelos racionales. Si se llegara a aplicar la 

fórmula de Hazen y Williams, se necesitarán los coeficientes de fricción que se encuentran 

en la tabla. Para casos de tuberías que no estén dentro de la tabla adjunta, se tendrán que 

argumentar los valores utilizados como coeficientes. Todas las tuberías y sus respectivos 

accesorios a ensamblar tienen que dar cumplimiento a las normas técnicas peruanas 

vigentes y aceptadas por la unidad y/o ente rector respectivo (RNE, OS.050, 2006). 
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Tabla 1.  

Coeficientes de fricción “C” en la fórmula Hazen y Williams 

TIPO DE TUBERÍA C 

Acero sin costura 

Acero soldado en espiral 

Cobre sin costura 

Concreto 

Fibra de vidrio 

Hierro fundido 

Hierro fundido dúctil con revestimiento 

Hierro galvanizado 

Polietileno 

Policloruro de vinilo (PVC) 

120 

100 

150 

110 

150 

100 

140 

100 

140 

150 

Nota: Adaptado de OS.050 “Redes de distribución de agua para consumo humano”.  

 

2.2.4 Elaboración de la simulación hidráulica 

2.2.4.1. Simulación 

La simulación es a un modelo lo que un experimento es a un sistema. Usando una 

terminología más clara, una simulación es un experimento realizado con un modelo. 

Simular es muy útil para analizar, controlar y diseñar (Sierra, 2011, pp. 430-431) 

¿Por qué la simulación resulta importante? 

A no ser que se experimente con el sistema real, la simulación es la técnica utilizable y 

más ahorrativa, y es un procedimiento sencillo para examinar la conducta de un 

procedimiento. Simulando se puede o se gana: 

 Comprender la correlación entre la causa y efecto de la realidad.   

 Fabricar diversas hipótesis en relación con la información.   

 Sintetizar la problemática y hacerla comprensible. 

La ganancia fundamental al emplear un Software en una simulación es que se pueda 

ensayar con un modelo y no “alterar” el sistema verdadero (Sierra, 2011, pp. 430-431) 

2.2.4.2. Software WaterCad 

Existen hoy en día muchas definiciones sobre el software Watercad, sin embargo, muy 

pocos de éstos nos dan una explicación precisa y detallada. Saldarriaga (2007) afirma: 
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WaterCAD V8 XM es un programa informático muy potente que puede utilizarse como 

herramienta de modelización hidráulica y calibración de redes para la mejor gestión 

integrada de los sistemas residenciales de distribución de agua. Algunas de las 

competencias de investigación que ofrece el programa WaterCAD son las siguientes: 

simulaciones hidráulicas que pueden ejecutarse durante mucho tiempo o de forma estática. 

Con el programa se pueden modelizar diversos componentes hidráulicos indicativos de las 

redes de distribución, como estaciones de bombeo, válvulas y controles automatizados 

con presión y caudal observables. Así mismo conviene emplear y simular varios escenarios 

con el propósito de examinar la conducta del sistema de distribución diseñado frente a 

demandas contrarias tomadas en principio, a calidades de agua inestables y a situaciones 

de percances y/o contratiempos, como puede ser los incendios o sectorización por estiaje, 

los cuales involucran a unas circunstancias de intervención muy particulares (p.533). 

2.2.4.3. La utilización de Software WaterCad 

El computer progran es un tipo de mercantil, que facilita la recopilación de la información 

respecto al proceder hidráulico que se representa en componentes de tipo líneas como 

divisiones de tubería, puntos como tanques, hidrantes o mixtos como bombas válvulas de 

regulación y vigilancia, su versión no se entrega en el español (Aguilar, 2015, p.11-12). 

Para una correcta aplicación del Watercad es inevitable hacer un estudio del proceder 

hidráulico, ya sea de situación estable alargado o de simulación en etapa espacioso (EPS) 

en la red de agua, este computer progran es provechoso para comprender:  

 Presiones y caudales. 

 Modelar tanques de llenado y vaciado.  

 Válvulas de regulación.  

 Edad del agua.  

 Calidad del agua.  

 Compara resultados con rapidez.  

 Análisis hidráulico.  

 Mezcla o combinas alternativas.  

Para realizar ajustes de calibración se debe examinar los criterios para que los caudales y 

las presiones concuerden, así también se debe ingresar la fórmula de la rugosidad para 

las adecuaciones en el programa, es fundamental evaluar con datos de campo ya que 

depende de estos para fabricar un resiente grupo de resultados (Aguilar, 2015, p.11-12). 

2.2.4.4. Patrones de tiempo 
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Aguilar (2015), afirma que, un patrón de tiempo tiene que ver con una serie de factores 

aplicables a una porción, para poder mostrar que cambia mientras se realiza la simulación, 

ellos serían gastos de caudal, altura de tanques, calidad de líquido y programas de bomba. 
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CAPÍTULO III  
MATERIALES Y MÉTODOS 

 

3.1. Ámbito y condiciones de la investigación 

3.1.1 Contexto de la investigación 

Políticamente el proyecto está ubicado en el sector Asociación Pro vivienda Nuevo 

Habana, Distrito de Habana, Provincia de Moyobamba, Departamento de San Martín. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figura 5.  
Ubicación del proyecto  
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3.1.2 Periodo de ejecución 

La ejecución del estudio comprendió el período del 05-07-2021 al 04-03-2022. 

3.1.3 Aplicación de principios éticos internacionales 

Ahora se declara que en el curso de esta investigación se siguieron las directrices de 

comportamiento responsable. 

3.2. Sistema de variables 

 Variable independiente: Diseño y simulación hidráulica con Watercad. 

 Variable dependiente: Red de distribución de agua potable de la Asociación Pro 

vivienda Nuevo Habana. 

3.3 Procedimientos de la investigación 

3.3.1 Procedimiento del objetivo específico 1 

Diseñar mediante cálculos hidráulicos la red de distribución de agua potable de la 

Asociación Pro vivienda Nuevo Habana. 

Recopilación de la información 

Se obtuvo el padrón de asociados y/o moradores de la Asociación Pro vivienda Nuevo 

Habana proporcionado por la Municipalidad Distrital de Habana, el cual contaba con una 

población de 621 habitantes; así también, se obtuvo información del INEI para determinar 

la población tasa de crecimiento de la población habanina. 

También se obtuvo el expediente técnico 

"MEJORA Y AMPLIACIÓN DEL SISTEMA DE AGUA POTABLE, CONSTRUCCIÓN DEL 

SISTEMA DE ALCANTARILLADO, CONEXIONES DOMICILIARIAS DE 

ALCANTARILLADO Y TRATAMIENTO DE AGUAS RESIDUALES, EN LA LOCALIDAD DE 

HABANA, DISTRITO DE HABANA - MOYOBANBA - SAN MARTIN". Elaborado en el año 

2017 por la Alcaldía Distrital de La Habana y tenía como objetivo conocer la capacidad del 

embalse., el caudal de diseño y las presiones más cercanas al área consideras en dicho 

expediente. En ella se pudo analizar documentos como: Memoria descriptiva, planos, 

metrados y especificaciones técnicas). 
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Procesamiento de la información 

Se determinó la población a 20 años, los parámetros de diseño hidráulicos de la red de 

distribución de agua potable y la capacidad de almacenamiento del reservorio existente de 

agua potable del distrito de Habana; para ello se utilizó las siguientes fórmulas: 

 Población futura:  
 

  𝑃𝑓 = 𝑃𝑎(1 + 𝑟. 𝑡)    

          Fuente: Vierendel, 2009.  

 

 

 

 Consumo medio:  

 

 

Fuente: RM N° 192-2018-VIVIENDA. 

 Caudal máximo diario:  

 

 

 

Fuente: RM N° 192-2018-VIVIENDA. 

Donde:  K1: Coeficiente de variación diario 1.3 
 

 Caudal máximo horario: 
 

 

Fuente: RM N° 192-2018-VIVIENDA. 

Donde: K2: Coeficiente de variación horario 1.8 

 

3.3.2 Procedimiento del objetivo específico 2 

Simular en periodo estático y periodo extendido la red de distribución de agua 

potable de la Asociación Pro vivienda Nuevo Habana con la aplicación del Watercad. 

Recopilación de la información 

Se realizó el levantamiento topográfico de la zona, determinando de esta manera la 

topografía real de la Asociación Pro vivienda Nuevo Habana, dicha información se procesó 

QpKQmd .1

QpKQmh .2

Donde: 𝑃𝑓: Población futura 

𝑃𝑎: Población actual 

  r: Tasa de crecimiento (%) 

  t:  tiempo de proyección (años) 

v 

v 
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en el Software Civil 3D, obteniéndose de esta manera las curvas de nivel. El trazado de 

las redes se realizó en el Software Civil 3D, con todo lo trabajado previamente en el 

Software antes descrito se realizó la simulación en el Software Watercad V8i. 

Figura 6.  
Levantamiento topográfico de la zona de estudio 

Con el levantamiento topográfico de la zona en estudio, se realizó la importación de los 

puntos en el Software Civil 3D; con ello se obtuvo las curvas de nivel y con ello se pudo 

importar desde el Watercad. 

Figura 7.  
Se aprecia las curvas de nivel obtenidas y georreferenciadas en el Software Civil 3D 
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Finalmente, luego de la obtención de las curvas de nivel, se pasó a obtener la topología 

y/o trazado de la red de distribución de agua potable en el Software Civil 3D.  

Figura 8.  
Se precia el trazado de las redes de distribución haciendo uso del Software Civil 3D 

Simulación Hidráulica con Software Watercad V8i. 

Apertura y configuración de la simulación 

Se comenzó la simulación aperturando el software Watercad V8i y creando un nuevo 

proyecto, para posteriormente configurar la escala de dibujo, las unidades y las etiquetas 

del nuevo proyecto dando click en la pestaña Tools➔ Options➔ 

Drawing➔Units➔Labeling. 

 

 

 

 

 

 

 

Figura 9.  

Configuración inicial del proyecto a desarrollar 
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Importación del trazo de la red de distribución  

A fin de poder contar con las redes de distribución que fueron trazadas en el Civil 3D se 

realizó la importación al Watercad siguiendo la ruta que se detalla a continuación: 

ModelBuilder➔ New➔ Select a data source type (Cad Files) ➔ Browse➔Next. ➔ Specify 

the coordinate unit of your data source (m) ➔ Next ➔Key Fields <label>➔Next ➔Yes ➔ 

Finish ➔ Yes ➔ Cerrar➔Yes. 

Figura 10.  

Red de distribución importada al Watercad 

 

Importación de curvas de nivel 

La importación de las curvas de nivel se realizó con la finalidad de poder obtener 

elevaciones topográficas nodos, reservorio y/o tuberías de la red de distribución, para lo 

cual se realizó siguiendo la ruta que se especifica a continuación: 

TRex ➔ Data Source Type (DXF contours) ➔ File ➔ Select Elevation Field (Elevation) ➔ 

X-Y Units (m) ➔ Z Units (m) ➔ Nodes to update (All) ➔ Next ➔ Finish. 

A fin de poder obtener una imagen referencial de las curvas de nivel importadas en el 

Watercad se importa las curvas de nivel como fondo de imagen siguiendo la siguiente ruta: 

View ➔ Background➔ New ➔ File. 
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Figura 11.  
Curvas de nivel del área de estudio, importadas 

Distribución de elevaciones en nodos y en reservorio 

La distribución de las elevaciones en los nodos se realizó de manera automática, al 

momento de realizar la importación de las curvas de nivel, para que la etiqueta de la 

elevación se muestre se sigue la siguiente ruta: 

View ➔ Juction ➔ New ➔ Anotation ➔ Field Name ➔ Elevation. 

 

Figura 12.  

Se aprecia al Nodo 1, con su respectiva elevación 
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Distribución de caudales en nodos 

La distribución de caudales se realizó con la ayuda de los polígonos de Thiessen y la ayuda 

del Software Arcgis, siguiendo la ruta que se detalla: 

Tools ➔ Thiessen Polygon ➔ Node Layer ➔ Juction/All Elements ➔ Next ➔ Poligon 

Boundary Layer ➔ Next ➔ Output file ➔ Finish. A fin de notar los polígonos se sigue la 

siguiente ruta: View ➔ Background➔ New ➔ File. 

Figura 13.  

Polígonos de thiessen que ayudan a repartir el caudal en los Nodos de la red de distribución 
 

 

 

 

 

 

 

 

 

 
Figura 14.  

Nodos de la red de distribución conteniendo los caudales demandados por la red. 
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Configuración de tuberías 

La configuración de las tuberías consistió principalmente en colocar diámetros, material de 

la tubería y coeficiente de Hazen – Williams, ello se realizó principalmente teniendo en 

cuentan lo especificado en la normativa peruana vigente, y para ello se siguió la siguiente 

ruta en el Watercad. View ➔ Flex Tables ➔ Pipe Table ➔ Material ➔ Diameter (mm). 

Figura 15.  
Diferentes tipos de diámetros de tuberías. 
 

Topología de la red de distribución en período estático  

Por último, se puede acceder a toda la topología de la red de distribución de agua potable 
de la Asociación Pro vivienda Nuevo Habana y a los resultados del periodo estático. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

 

Figura 16.  
Red de distribución de agua potable simulada en período estático 
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Colocación de variaciones horarias  

 

Las variaciones horarias, se configuraron con la finalidad de poder obtener información 

respecto al comportamiento horario del día de mayor consumo de la red, para ello se tuvo 

que tener en cuenta el tiempo de servicio que brinda la municipalidad distrital de Habana. 

La ruta seguida en el Watercad fue la siguiente: Components ➔ Patterns ➔ Hydraulic ➔ 

New ➔ Close 

 

Figura 17.  

Se aprecia los picos de consumo mayores y menores de la red de distribución de agua 
potable 
 

 

Topología de la red de distribución período extendido  

 

Después de a ver ingresado las Variaciones horarias, éstas se computaron haciendo click 

en el botón Compute, obteniéndose de esta manera la topología completa de la red de 

distribución en período extendido. 
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Figura 18.  
Se aprecia la variación horaria sometida a la red de distribución de agua potable 
 

 

3.3.3 Procedimiento del objetivo específico 3  

Determinar velocidades, diámetros de tuberías y presiones en la red de distribución 

de agua potable de la Asociación Pro vivienda Nuevo Habana. 

La ejecución del objetivo específico 3, se desarrolló tomando como referencia el 

Reglamento Nacional de Edificaciones en su apartado OS.050 Redes de distribución de 

agua para consumo humano, la cual es la normativa peruana vigente.  

En tal sentido, se tomó las consideraciones mínimas y máximas establecidas en la 

normativa antes descrita, a fin de poder considerarlas en el diseño de la red de distribución 

de agua potable e la Asociación.  
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CAPÍTULO IV  
RESULTADOS Y DISCUSIÓN 

4.1. Cálculos hidráulicos de la red de distribución de agua potable de la Asociación 

Pro vivienda Nuevo Habana 

Los resultados de la caracterización de la zona de estudio, fueron procesados en la tabla 

2, la misma que se conoce como parámetros de diseño, básicos para la Simulación 

Hidráulica en periodo estático y en período extendido. 

 

Tabla 2.  

Datos considerados para el cálculo del caudal de diseño  

Parámetros de diseño 

Ubicación: 

Departamento San Martín 

Provincia Moyobamba 

Distrito Habana 

Localidad Asociación Pro Vivienda Nuevo Habana 

Datos de población: 

Población base 517 habitantes  

Tasa de crecimiento poblacional 1.00% (Fuente: INEI-2007, 2017) 

Periodo de diseño 20 años 

Método de diseño Método aritmético 

Población futura  621 habitantes 

Instituciones y/o similares: 

Casa comunal Aforo 50 habitantes 

Mercado Aforo 150 habitantes 

Educación inicial 45 alumnos 

Educación primaria 120 alumnos 

Dotaciones: 

Dotación poblacional 220 lt/hab/día (RNE-OS 100) 

Dotación institucional 20 lt/hab/día (IS 010) 

Coeficientes de variación 

Coeficiente de variación diaria  1.3 (RNE – OS 100) 

Coeficiente de variación horaria 1.8 (RNE – OS 100) 

Caudales de gasto: 

Caudal medio 2.13 lt/s 

Caudal máximo diario 2.77 lt/s 

Caudal máximo de horario 3.83 lt/s 

Volumen del reservorio existente: 

Reservorio existente 250 m3. (ATM-MDH) 
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De la tabla 2 se puede apreciar que se ha considerado una población base de 517 

habitantes, según padrón de moradores proporcionado por la Municipalidad distrital de 

Habana, con una tasa de crecimiento poblacional de 1.00% calculada del promedio 

intercensal INEI 2007, 2017; y que, según Reglam. Nac. de Edificaciones, las redes de 

distribución de agua potable se diseñan para una etapa de 20 años; así mismo, se utilizó 

el método aritmético por tratarse de una pequeña ciudad. 

También se puede apreciar que se han considerado edificaciones como una casa comunal, 

un mercado y dos instituciones educativas, tal como se consideró en el plano catastral 

proporcionado por la municipalidad, a los que, en el caso de la institución educativa inicial, 

se consideró 3 aulas de 15 alumnos cada uno, y en la institución educativa primaria se 

consideró 6 aulas de 20 alumnos cada uno.  

De lo calculado, se pudo obtener por caudal medio de 2.13 lt/s, caudal máximo diario de 

2.77 lt/s, caudal máximo horario 3.83 lt/s y un almacenamiento en el reservorio de 250 m3 

dato proporcionado por la municipalidad distrital de Habana. 

4.2. Simulación en periodo estático y periodo extendido de la red de distribución de 

agua potable de la Asociación Pro vivienda Nuevo Habana con la aplicación del 

Watercad 

4.2.1. Simulación en período estático   

La simulación en período estático se realizó con la finalidad de mirar el desarrollo de la red 

en un momento cualquiera, es decir en un instante; este análisis se realiza en un periodo 

al azar, como aparentando un seguimiento habitual del comportamiento de la red. 

 

Tabla 3.  

Resultado de caudal y elevación en nodos. 

Label 
Elevation 

(m) 

Demand 

(L/s) 

N-1 841.50 0.12 

N-2 841.09 0.12 

N-3 842.50 0.09 

N-4 842.25 0.04 

N-5 842.50 0.05 

N-6 841.78 0.04 

N-7 841.46 0.03 

N-8 841.53 0.03 
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N-9 842.14 0.02 

N-10 842.16 0.08 

N-11 841.96 0.07 

N-12 842.50 0.08 

N-13 842.33 0.11 

N-14 842.48 0.09 

N-15 841.93 0.08 

N-16 842.34 0.08 

N-17 842.69 0.08 

N-18 842.16 0.03 

N-19 842.58 0.06 

N-20 842.72 0.05 

N-21 843.00 0.10 

N-22 843.00 0.08 

N-23 843.01 0.08 

N-24 842.07 0.07 

N-25 839.80 0.08 

N-26 839.50 0.07 

N-27 840.36 0.06 

N-28 839.90 0.08 

N-29 843.00 0.08 

N-30 843.40 0.08 

N-31 842.71 0.09 

N-32 842.50 0.10 

N-33 842.51 0.07 

N-34 842.70 0.03 

N-35 842.41 0.03 

N-36 842.08 0.03 

N-37 842.70 0.04 

N-38 843.42 0.08 

N-39 843.50 0.12 

N-40 843.41 0.10 

N-41 840.00 0.08 

N-42 841.09 0.08 

N-43 843.03 0.05 

N-44 843.57 0.08 
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N-45 840.71 0.09 

N-46 841.97 0.07 

N-47 842.35 0.05 

N-48 844.00 0.03 

N-49 844.50 0.04 

N-50 839.86 0.06 

N-51 844.00 0.05 

N-52 843.92 0.05 

N-53 838.78 0.04 

N-54 840.00 0.03 

N-55 843.67 0.05 

N-56 843.85 0.04 

N-57 843.50 0.04 

N-58 843.16 0.03 

N-59 841.73 0.02 

 

De la tabla 3 se puede apreciar que, según la topología establecida, se consideraron 

cincuenta y nueve (59) nodos, las cuales están ubicadas en cada encuentro y/o cruce de 

dos tuberías a más; así mismo, se puede apreciar que cada nodo cuenta con su elevación 

topográfica respectiva y, un caudal de 3.83 L/s que fue distribuido en toda la red de 

distribución según lo demandado por la población considerada. 

 

Tabla 4.  

Resultado de caudal y longitud de tuberías 

Tubería 

Length 

(Scaled) 

(m) 

Start 

Node 

Stop 

Node 

Flow 

(L/s) 

TUB PVC-UF DN-90MM C-10 551.75 Res. Existente N-1 3.83 

TUB PVC-UF DN-90MM C-10 46.78 N-55 N-58 0.09 

TUB PVC-UF DN-75MM C-10 77.61 N-3 N-12 1.02 

TUB PVC-UF DN-75MM C-10 71.52 N-11 N-6 0.02 

TUB PVC-UF DN-50MM C-10 48.82 N-48 N-49 0.04 

TUB PVC-UF DN-50MM C-10 18.16 N-58 N-59 0.02 

 

De la tabla 4, se puede apreciar que, como resumen se han considerado tres tipos de 

diámetros de tuberías, de los cuales el mayor caudal distribuido en la tubería de 90 mm es 
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de 3.83 l/s y va desde el reservorio existente (Res. Existente) hasta el nodo 1 (N-1) y el 

caudal mínimo distribuido en la tubería de 90 mm es de 0.09 l/s y va desde el nodo 55 (N-

55) al nodo 58 (N-58); también se puede apreciar que en la tubería de 75 mm el caudal 

máximo es de 1.02 l/s y va desde el nodo 3 (N-3) al nodo 12 (N-12) y el caudal mínimo 

distribuido en la tubería de 75 mm es de 0.02 l/s y va desde el nodo 11 (N-11) al nodo 6 

(N-6); finalmente también se aprecia que en la tubería de 50 mm el mayor caudal distribuido 

es de 0.04 l/s y va desde el nodo 48 (N-48) al nodo 49 (N-49) y el caudal mínimo distribuido 

es de 0.02 l/s y va desde el nodo 58 (N-58) al nodo 59 (N-59); vale decir que éstos son 

debido a que el sistema se encuentra en periodo estático, lo que se deduce que no existe 

un consumo considerable. 

4.2.2.  Simulación en periodo extendido 

Para ver cómo evoluciona el comportamiento de la red de distribución a lo largo de estos 

intervalos y/o variaciones temporales, esta simulación representa la red en varios 

intervalos y/o variaciones temporales. 

 

Tabla 5.  

Variaciones de consumo horario  

HORA 
Coeficiente de 

variación horaria  

00:00 0.1 

01:00 0.1 

02:00 0.1 

03:00 0.1 

04:00 0.2 

05:00 0.3 

06:00 0.8 

07:00 0.8 

08:00 0.7 

09:00 0.6 

10:00 0.6 

11:00 0.7 

12:00 0.7 

13:00 0.7 

14:00 0.5 

15:00 0.6 
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16:00 0.6 

17:00 0.7 

18:00 1.1 

19:00 0.9 

20:00 0.8 

21:00 0.5 

22:00 0.2 

23:00 0.1 

 

 

En la tabla 5, se puede apreciar que se han considerado las fórmulas de variación horaria 

del día de mayor gasto, donde se puede apreciar que el mayor gasto de agua potable se 

da por las mañanas y en las tardes del día, esto debido a que el distrito de Habana cuenta 

con una población que vive mayormente de la agricultura, lo que refleja los mayores 

consumos.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Figura 19.  
Patrones de consumo horario adoptados para la investigación 
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En la figura se puede apreciar, el pico de consumo más alto que se encuentra a las 18:00 

horas; así también se puede apreciar las líneas de consumo mínimas que se encuentran 

entre las 23:00 y las 03:00 horas. 

 

Tabla 6.  

Resultados de caudal mínimo y máximo recorrido en redes. 

Tubería 

Length 

(Scaled) 

(m) 

Flow 

minimum 

(L/s) 

Flow 

maximum 

(L/s) 

TUB PVC-UF DN-90MM C-10 551.75 0.38 3.83 

TUB PVC-UF DN-75MM C-10 55.26 0.00 0.02 

TUB PVC-UF DN-50MM C-10 18.16 0.00 0.03 

 

De la tabla resumen anterior, se puede apreciar que el caudal mínimo distribuido en las 

redes se encuentra entre las 23:00 y las 03:00 horas y es de 0.38 y 0.00 L/s en algunos 

sectores respectivamente; y, el caudal máximo distribuido en las redes corresponde a las 

18:00 horas y tiene un caudal de 3.83 y 0.02 L/s en algunos sectores respectivamente. 

Esto se puede apreciar a mejor detalle en los anexos, donde se adjunta la totalidad de los 

caudales máximos y mínimos determinados por el Software Watercad. 

4.3. Determinación de velocidades, diámetros de tuberías y presiones en la red de 

distribución de agua potable de la Asociación Pro vivienda Nuevo Habana. 

 

Tabla 7.  

Velocidades en periodo estático. 

Tubería 

Length 

(Scaled) 

(m) 

Velocity 

(m/s) 

TUB PVC-UF DN-90MM C-10 551.75 0.60 

TUB PVC-UF DN-75MM C-10 4.48 0.60 

TUB PVC-UF DN-75MM C-10 71.71 0.00 

 

En la tabla 7, se puede apreciar una muestra de las velocidades mínimas y máximas 

obtenidas de la simulación en período estático, de las cuales la velocidad mínima se 

encuentra en 0.00 m/s y la máxima de 0.60 m/s, esto se encuentra restringida por la 
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cantidad de caudal distribuida en la red la cual es de 3.83 l/s; Además, hay que recordar 

que la simulación del periodo estático se realizó con la intención de visualizar la actividad 

de la red en un instante determinado. 

 

Tabla 8.  

Velocidades en período extendido 

Tubería 

Length 

(Scaled) 

(m) 

Velocity 

minimum 

(m/s) 

Velocity 

maximum 

(m/s) 

TUB PVC-UF DN-90MM C-10 46.78 0.06 0.6 

TUB PVC-UF DN-90MM C-10 551.75 0.00 0.02 

 

En la tabla 8, se puede apreciar que existen velocidades mínimas y máximas, las cuales 

corresponden a los menores y mayores consumos horarios durante el día de mayor 

consumo, en tal sentido las velocidades mínimas corresponden al intervalo horario de las 

00:00 horas y las 04:00 horas; y, las velocidades mayores, corresponden a las 18:00 horas, 

teniendo en cuenta dichas velocidades, es necesario recalcar que para una mejor 

eficiencia de la red de distribución de agua potable será necesario considerar válvulas de 

purga y/o aire a fin de que se eviten os sedimentos en las tuberías debido a las bajas 

velocidades existentes. 

 

Tabla 9.  

Diámetros de tuberías adoptadas 

Pipe 
Length (Scaled) 

(m) 

TUB PVC-UF DN-90MM C-10 1037.02 

TUB PVC-UF DN-75MM C-10 5250.35 

TUB PVC-UF DN-50MM C-10 328.37 

 

De la tabla 9 se puede apreciar que se han considerado tres tipos de diámetros diferentes, 

los cuales se consideraron teniendo en cuenta la normativa peruana vigente (OS 050), así 

como también con el propósito de garantizar las mejores presiones en toda la red de 

distribución; las tuberías de 90mm serán utilizadas como tuberías principales, las tuberías 

de 75 mm serán utilizadas como tuberías secundarias y las tuberías de 50 mm como 

tuberías auxiliares. Con los diámetros considerados se pudo obtener presiones eficientes 

tal como se muestra en el cuadro siguiente. 
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Tabla 10.  

Presiones en periodo estático 

Label 
Elevation 

(m) 

Pressure 

(m H2O) 

N-49 844.50 18.56 

N-53 838.78 24.30 

 

La red de distribución de agua potable, cuenta con 59 nodos distribuidos en distintas zonas 

de la red, en la Tabla 10, se puede apreciar las presiones mínimas y máximas en metros 

columna de agua obtenidas en la simulación en período estático, las cuales se encuentran 

en los nodos 49 y 53 respectivamente; de estos se puede afirmar que la red de distribución 

de agua potable es eficiente en su funcionamiento, ya que la OS. 050, establece que se 

deben garantizar como presiones mínimas 10 metros columna de agua. 

 

Tabla 11.  

Presiones en período extendido 

Label 
Elevation 

(m) 

Pressure 

minimum 

(m H2O) 

Pressure 

maximum 

(m H2O) 

N-49 844.50 18.51 20.95 

N-53 838.78 24.26 26.66 

De los 59 nodos establecidos en la red de distribución de agua potable, en la tabla 11, se 

puede apreciar que la presión mínima se encuentra en el nodo 49 la cual es de 18.51 

metros columna de agua y la presión máxima se encuentra en el nodo 53 la cual y es de 

26.66 metros columna de agua, dichas presiones corresponden a las 18:00 horas y 00:00 

horas respectivamente; de lo mostrado en el cuadro, se puede afirmar que la red de 

distribución en período extendido es eficiente, ya que lo mínimo requerido por la OS. 050 

es de 10 metros columna de agua. 

 

4.4. Discusiones. 

Yarleque (2019), haciendo uso de Software Watercad, determinó la presión estática 

máxima y mínima de 18.85 m.c.a y 15.66 m.c.a respectivamente, así como velocidad 

máxima de 1.86 m/s y velocidad mínima de 0.14 m/s, también determinó diámetros de 

tuberías en pulgadas que se establecieron en 2 ½” en una longitud de 645m, 3” en una 

longitud de 21.76m y 4” con una longitud de 272.64m. En la presente investigación, también 
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se determinaron presiones estáticas máximas y mínimas de 24.30 m.c.a. y 18.56 m.c.a. 

respectivamente, así también, velocidades máximas y mínimas que se encuentran entre 

0.00 m/s y 0.60 m/s respetivamente; respecto a los diámetros de tuberías, se consideraron 

diámetros de tuberías milimétricos, las cuales fueron de 90 mm en una longitud de 1037.02 

m, 75 mm en una longitud de 5250.35 y 50 mm en una longitud de 328.37 m. 

 

Valenzuela y Orillo (2019), haciendo uso del Software Watercad, realizó el modelamiento 

en período estático y en período extendido de la red de la localidad de Paucartambo, en 

ella determinó que la simulación de la red de distribución de agua potable se acerca más 

a la realidad cuando se consideran el agua no facturada de la localidad. En ese sentido, 

en la presente investigación, con el fin de conocer mucho más de cerca la conducta de la 

red de distribución, se realizó la simulación en período extendido, entendiéndose que se 

dará con la finalidad de ver el comportamiento de las redes cuando se encuentran en 

funcionamiento a lo largo de un día de mayor consumo. 

 

Quilca (2020), muestra picos y caídas en el transcurso de las horas del día, resultando el 

gasto máximo horario de 32.46 litros; paralelamente, se observa un incremento revelador 

en el máximo coeficiente de variación horaria (K2=3.09) en relación al coeficiente de 

variación horaria teórica (K2=1.8-2.5). Es así que, en la presente investigación, se 

determinó que la cantidad máxima horario es de 3.82 l/s, la cual se determinó haciendo 

uso de la relación de variación horaria del reglamento nacional de edificaciones. 

 

Torres (2019), en su tesis examinó líneas primarias con diámetro 110 mm y líneas 

secundarias con diámetro 90 mm, siendo ambas líneas de material HDPE, debido a la 

fortaleza y perennidad; así mismo, con la simulación hidráulica se obtuvo el desempeño 

eficaz de las redes de distribución consiguiéndose obtener el 100% de las presiones y 

100% de las velocidades dentro de la categoría establecida en el Reglamento Nacional de 

Edificaciones. Así también, en la presente investigación se han determinado diámetros de 

tuberías de 90 mm, 75 mm y 50 mm que serán utilizadas como primarias, secundarias y 

auxiliares respectivamente, finalmente con la presente investigación también se lograron 

obtener presiones y velocidades que conllevarán al correcto funcionamiento de la red de 

distribución de agua potable de la Asociación. 
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CONCLUSIONES 

 

El diseño de red de distribución de agua potable en la Asociación Pro vivienda Nuevo 

Habana es eficiente,  ya que la investigación se realizó teniendo en cuenta los criterios 

técnicos mínimos de ingeniería tales como visitas de campo, reuniones de coordinación y 

cálculos hidráulicos,  a fin de obtener la población futura y con ello los caudales de diseño 

para un período de tiempo mínimo de 20 años, tal como lo establece la RM N°153-2019-

VIVIENDA, dando éstos como resultado una población de diseño de 3190 moradores, el 

cual arrojó un caudal máximo horario de 3.83 l/s, con el que posteriormente se realizó el 

modelamiento hidráulico en período estático y extendido; teniendo en cuenta también, que 

para una eficiente simulación hidráulica se tuvo que tener en cuenta la capacidad de 

almacenamiento del reservorio existente, la cual es de 250 m3 . 

 

El diseño de red de distribución de agua potable de la Asociación Pro vivienda Nuevo 

Habana resulta eficiente, ya que, la simulación hidráulica en periodo estático, arrojó 

resultados de presión mínima de 18.56 m.c.a., muy por encima de lo requerido por la OS. 

050, ello haciendo uso de los diámetros de tuberías de 50mm, 75mm y 90 mm, los cuales 

son recomendadas en la norma antes mencionada. Así mismo, referente a la simulación 

hidráulica en período extendido, esta se realizó también haciendo uso de los mismos 

diámetros de tuberías del período estático y teniendo en cuenta los consumos horarios del 

día de mayor consumo, en ello se observó que la presión mínima garantizada es de 20.95 

m.c.a., a las 18:00 horas del día, la cual es la hora de mayor consumo, teniendo en cuenta 

que la población en un 90% se dedicada a la agricultura. 

 

Con el modelamiento de esta red de distribución de agua potable de la Asociación Pro 

Vivienda Nuevo Habana, se garantiza que se contará con la continuidad y cobertura 

necesaria para un eficiente servicio en la zona, ya que el modelamiento se realizó 

incluyendo sectores aledaños a la zona de investigación, así como también, proyectando 

tuberías que garanticen el abastecimiento en futuras expansiones urbanas, concluyéndose 

de ésta manera que la red de distribución es eficiente en funcionamiento actual y en 

proyección futura a 20 años. 
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RECOMENDACIONES 
 

A los futuros investigadores que deseen implementar una simulación hidráulica de una 

red de distribución de agua potable, recomendar que, para que la simulación hidráulica 

se pueda realizar sin ningún inconveniente, se debe considerar una fuente de 

almacenamiento (reservorio), ya que, al no existir, no se podrá realizar la simulación, 

debido a que el Software interpreta que no existe fuente de abastecimiento de donde 

se pueda proveer de agua a la red de distribución. 

 

Al realizar la simulación hidráulica en período extendido con la ayuda del Software 

watercad, se debe tener en cuenta que se requiere hacer uso de las variaciones de 

consumo horario, por lo que ésta se debe obtener en campo y por un periodo de tiempo 

determinado; ya que ello, hará ver los picos de consumo durante el día de mayor 

consumo, así como también hará que la simulación en la red se acerque mucho más a 

la realidad, haciendo de que se puedan determinar las presiones máximas y mínimas 

durante su funcionamiento. 

 

Al implementar el presente sistema en campo, realizar un replanteo final, tanto en 

topografía como en evaluación poblacional, ya que actualmente la población y la 

asociación objeto de estudio se encuentra en constante crecimiento y expansión 

demográfica; lo que influirá en los caudales de diseño y la proyección de la misma a 

futuro. 

 

A la municipalidad distrital de Habana, se recomienda la implementación de al menos 

dos (02) macromedidores tanto a la entrada del reservorio y a la salida de la misma, a 

fin de calcular la cantidad de caudal que ingresa y se comparte a la población mediante 

las redes de distribución de agua potable, ello ayudará en la toma de decisiones para 

mejorar el servicio tanto en continuidad y cobertura, así como poder determinar si la red 

existente en la zona es eficiente a fin de poder implementar la presente en campo y 

poder mejorar el servicio de agua potable.  

 

A la Municipalidad Distrital de Habana, al momento de implementar la presente en 

campo, tener en cuenta que también se debe implementar la recolección de la misma, 

ya que hoy en día es menester contar con proyectos de inversión públicos integrales, 

es decir que cuenten con agua, desagüe y recolección de agua pluviales. 
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ANEXOS 

 

Plano 1: Plano de Lotización. 
 
Plano 2: Plano Topográfico. 
 
Plano 3: Simulación hidráulica en período estático 
 
Plano 4: Simulación hidráulica en período extendido. 
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